
www.telemecaniquesensors.com

User Guide

RFID OsiSense® XG

Original instructions

PROFIBUS Splitter Box

TESEUG000261EN



Legal Information

The information provided in this guide contains description of products sold by 
TMSS France, its subsidiaries and other affiliated companies (‘Offer’) with technical 
specifications and technical characteristics of the performance of the corresponding 
Offer. 

The content of this document is subject to revision at any time without notice due to 
continued progress in methodology, design and manufacturing. 

To the extent permitted by applicable law, no responsibility or liability is assumed 
by TMSS France, its subsidiaries and other affiliated companies for any type of 
damage arising out of or in connexion with (a) informational content of this guide not 
conforming with or exceeding the technical specifications, or (b) any error contained 
in this guide, or (c) any use, decision, act or omission made or taken on the basis of 
or in reliance on any information contained or referred to in this guide. 

NEITHER TMSS FRANCE, ITS SUBSIDIARIES, NOR ITS OTHER AFFILIATES, 
AS THE CASE MAYBE, MAKE NO WARRANTY OR REPRESENTATION OF ANY 
KIND, WHETHER EXPRESS OR IMPLIED, AS TO WHETHER THIS GUIDE OR 
ANY INFORMATION CONTAINED THEREIN SUCH AS PRODUCTS WILL MEET 
REQUIREMENTS, EXPECTATIONS OR PURPOSE OF ANY PERSON MAKING 
USE THEREOF.

TelemecaniqueTM Sensors is a trademark of Schneider Electric Industries SAS 
used under license by TMSS France. Any other brands or trademarks referred to in 
this guide are property of TMSS France or, as the case may be, of its subsidiaries 
or other affiliated companies. All other brands are trademarks of their respective 
owners.

This guide and its content are protected under applicable copyright laws and 
provided for informative use only. 

No part of this guide may be reproduced or transmitted in any form or by any means 
(electronic, mechanical, photocopying, recording, or otherwise), for any purpose, 
without the prior written permission of TMSS France. Copyright, intellectual, and 
all other proprietary rights in the content of this guide (including but not limited to 
audio, video, text, and photographs) rests with TMSS France, its subsidiaries, and 
other affiliated companies or its licensors. All rights in such content not expressly 
granted herein are reserved. No rights of any kind are licensed or assigned or shall 
otherwise pass to persons accessing this information.
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Safety Information

Safety Information

Important Information

Read these instructions carefully, and look at the equipment to become familiar 
with the device before trying to install, operate, service, or maintain it. The following 
special messages may appear throughout this documentation or on the equipment 
to warn of potential hazards or to call attention to information that clarifies or 
simplifies a procedure.

Please Note

Our product should be installed, operated and maintained only by qualified 
personnel. Neither TMSS France nor any of its subsidiaries or other affiliated 
companies shall be responsible or liable for any consequences arising out of the use 
of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and its installation, and has received safety 
training to recognize and avoid the hazards involved.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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About the Book

About the Book

Document Scope
This document describes the installation and use of the OsiSense® XG PROFIBUS 
Splitter Box.

The OsiSense® XG PROFIBUS Splitter Box enables OsiSense® XG compact RFID 
stations to be connected on PROFIBUS-DP network  in distributed automation 
systems using pre-assembled cables.

This splitter box is used to connect three XGCS compact stations on a PROFIBUS-
DP network (up to 15 stations could be connected with T-connectors).

As a server on the network, the splitter box can receive and respond to data 
messages.

This data exchange allows your network accessing some OsiSense® XG station 
functions, such as:

•	 	Reading/writing tags,
•	 	Control and command,
•	 	Monitoring,
•	 	Diagnostics.

Validity Note

The technical characteristics of the devices described in this manual also appear 
online.

To access this information online:

Step Action
1 Go to www.telemecaniquesensors.com
2 In the Search box, type the model number of a product or the name of a product 

range.Do not include blank spaces in the model number/product range.
3 If more than one model number appears in the Products search results, click on 

the model number that interests you.
4 To save or print a data sheet as a .pdf file, click Download product datasheet.

The characteristics that are described in the present document should be the 
same as those characteristics that appear online. In line with our policy of constant 
improvement, we may revise content over time to improve clarity and accuracy. If 
you see a difference between the document and online information, use the online 
information as your reference.

Related Documents

Title of Documentation Reference Number
User Guide: OsiSense®  XG Compact Stations 1655669 01

You can download these technical publications and other technical information from 
our website at www.telemecaniquesensors.com.

http://www.telemecaniquesensors.com
http://www.telemecaniquesensors.com


7

PROFIBUS Splitter Box

TESEUG000261EN

About the Book

User Comments

We welcome your comments about this document. You can reach us through the 
customer support page on your local TeSensors website.

Information on Non-Inclusive or Intensitive Terminology

As a responsible, inclusive company, TMSS France is constantly updating its 
communications and products that contain non-inclusive or insensitive terminology. 
However, despite these efforts, our content may still contain terms that are deemed 
inappropriate by some customers.
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Presentation

Presentation
Introduction

This chapter presents the OsiSense® XG PROFIBUS Splitter Box and the 
associated range of accessories.

Overview
Introduction

This section gives a detailed technical description of the OsiSense® XG PROFIBUS 
Splitter Box.

Description

N° Description
1 2 Rotary switches for addressing setup
2 Input PROFIBUS connector (M12 5-pins male, B-coding) 
3 3 OsiSense® XG compact station connector (M12 5-pins female, A-coding)
4 Power supply connector (M12 4-pins male, A-coding)
5 Configuration port (M12 female, A-coding) (for TMSS use only)
6 Signaling LEDs for the PROFIBUS fieldbus, Modbus fieldbus and splitter box 

status
7 Output PROFIBUS connector (M12 5-pins female, B-coding)

1

2 3 4 5 6 7
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Overview of the Accessories Range

Connection Accessories

(1) Refer to OsiSense® XG compact stations user guide for compact stations 
accessories.

Element Type of cable/connectors Application Cable 
length 
(m)

Reference

1 Pre-wired M12 4-pin female connector, 
A-coding

Power supply 
connection

2 XGS Z09L2
5 XGS Z09L5
10 XGS Z09L10

2 Supply connector, screw terminals, M12 
straight, A-coding 

- XZC C12FDM40B

3 Protective cap - - ASI67FACC1

3 1 2

(1)
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Installation

Installation

Installing the Splitter Box

Description

The OsiSense® XG PROFIBUS Splitter Box can be mounted directly onto a wall or a 
machine. Four threaded mounting holes have been provided for this purpose inside 
the splitter box.

WARNING
LOSS OF ENCLOSURE PROTECTION
To achieve enclosure protection level of IP65:

•	 Proprely fit all connectors with cables or sealing plugs and tighten.
•	 Install cover onto the splitter bow and tighten screws to 0.5-3.0 Nm (4.4-26.5 lb-in).

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.

Dimensions
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EMC Compatibility

Product Compliance

This product complies with the European directive 2014/30/EU on "electromagnetic 
compatibility".

The products described in this manual meet all the electromagnetic compatibility 
(EMC) requirements and are compliant with the applicable standards. To 
maintain electromagnetic compatibility in each particular end use application, the 
system designer must use EMC compliant and certified components and follow 
manufacturers instructions, work practices and applicable codes and standards 
related to EMC compliant installations.

The product described in this manual contains highly complex semiconductors that 
can be damaged or destroyed by electrostatic discharge (ESD). Care must be taken 
to avoid product damage from ESD. For example, the use of this product within 
the vicinity of devices rated as class A or B according to IEC 61000-4-4, may result 
in damage to this device. The effects of ESD damage, including the possibility of 
unintended equipment operation, may not be immediately detectable.

 WARNING
UNINTENDED EQUIPMENT OPERATION

Where there is a risk of electromagnetic interference, the systhem designer must implement 
the protective measures :

•	 Do not expose electronic circuits to sources of Electrostatic Discharge.
•	 Avoid touching internal circuit with skin, clothing or tools.

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.
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Installation

Cable Routing

Make sure that the following basic wiring rules are followed:

•	 Keep the data wire and the power cables apart from one another, in so far as is 
possible.

•	 Make sure there is a space of at least 10 cm (3.94 in) between the data wires 
and the power cables.

•	 The data wires and power cables must only cross at a right angle to one 
another.

•	 It is advisable to route the data wires and power cables through separate 
shielded ducts.

•	 When laying the cables, the noise voltage from other devices or wires must be 
considered. This particularly applies to frequency converters, motors and other 
devices or cables generating high frequency disturbances. High frequency 
sources and the cables described in this manual must be as far apart from each 
other as possible.

•	 The power supply must come from a Protected Extra Low voltage (PELV) power 
unit.

•	 The 0V of the PELV power unit must be connected to the earth.

 WARNING
UNINTENDED EQUIPMENT OPERATION

•	 The cable routing rules listed above must be followed.
•	 Cable routing is important for proper Electromagnetic Compatibility (EMC). 

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.
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Splitter Box Characteristics and Wiring

Characteristics
Environment Characteristics 

Characteristic Description
Operating temperature 0...+55°C (-32...+131°F)
Storage temperature -25...+85°C (-13...+185°F)
Relative humidity 30...95% non condensing
Degree of protection IP65
Vibration resistance conforming to IEC 60068-2-6 2 mm from 5 to 29.5 Hz / 7 gn from 

29.5 to 150 Hz
Shock resistance conforming to IEC 60068-

2-27
30 g/11 ms 

Impact resistance conforming to IEC 62262 Degree IK04
Dimensions (except connectors) 160 x 100x 60 mm (6.3 x 3.94 x 2.36 

in)
Weight 871 g (30.72 oz)
Electromagnetic immunity 
conforming to

EN 61000-
6-2

Level 3

Electromagnetic emissions 
conforming to

EN 55022 Class B

NOTICE
RADIO INTERFERENCE 

•	 This Class B product may cause radio interference.
•	 Implement reduction techniques in applications where radio interference is objectio-

nable.
Failure to follow these instructions can result in equipment damage.

Electrical Characteristics 

Characteristic Description
Power supply voltage 24 VDC SELV/PELV (limits 21.6...26.4 V)
Power consumption (Splitter Box only) < 2.5 W
Connector M12 4-pin male, A-coding

PROFIBUS Fieldbus Characteristics

Characteristic Description
Topology Linear bus with terminators
Transmission mode Half Duplex
Transmission rate 9.6 / 19.2 / 93.75 / 187.5 / 500 / 1500 / 3000 / 6000 / 

12000 Kbits/s - Automatic detection
Transmission media Twisted pair line (RS 485)
Connector M12 5-pin, B-coding
Cyclic Transmitted Data (in words) - Input: 5 for control + < 43 for user’s data

- Output: 7 for control + < 41 for user’s data
Acyclic transmitted data Not supported
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Splitter Box Characteristics and Wiring

RFID Station Communication Characteristics

Characteristic Description
Transmission rate 38400 Bits/s
Time-out 3 s (after 3 automatic retries)
Quantity of RFiD stations 3 (direct connection) to 15 (chained with M12 tees)
Total length of the RFiD connections 160 m max (525 ft)
Connector M12 5-pin female, A-coding
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Connectors description

Pin Assignment

Connector Pin Color Assignment
Stations connector (M12 5-pin female, A-coding) 1 - GND

2 - 24 VDC
3 - 0 VDC
4 - D0
5 - D1

Power supply connector (M12 4-pin male, 
A-coding)

Power supply cable XGS Z09L••

1 Red 24 VDC
2 - NC
3 Black 0 VDC
4 - NC

NOTE : The M12 configuration connector is only for TMSS use.

3 4

2 1
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PROFIBUS Network Interface

PROFIBUS Network Interface
Introduction

This chapter provides theoretical background on PROFIBUS fieldbus operation.

Wiring to the PROFIBUS Fieldbus
Introduction

The following section describes the element required for wiring the splitter box to the 
PROFIBUS fieldbus.

Fieldbus Connection

Description

The splitter box can either be in the middle of the chain connection or at line end. 
The fieldbus is connected via  5-pin M12 connectors (B-coding). 

Pin Assignment

The following diagram shows a front view of the bus connectors (B-coding)

Pin Signal Description
1 VP Line terminator polarization voltage
2 A - RxD/TxD-N Receive/transmit data - negative (green)
3 DGND Discrete earth
4 B - RxD/TxD-P Receive/transmit data - positive (red)
5 Shielding Shielding or earthing
Connector housing Shielding Shielding or earthing

NOTE : It is preferable to connect the shielding to the connector housing. If 
this is not possible, the connection can also be made using pin 5. These two 
possibilities can also be combined.

BUS
OUT

BUS
IN

5

3

2

4

1

5
2

3

1

4
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PROFIBUS Network Interface

Correspondance between SUB-D 9-pin Connectors and M12 5-pin Connec-
tors

The following table shows the correspondence between pins on 9-pin SUB-D 
connectors and on 5-pin M12 connectors:

9-pin SUB-D         
connector

SUB-D 
pin

Signal Meaning M12 pin 5-pin M12 
connector

1 Shielding Shielding/earthing 5
2 M24 24 V output earth -
3 B-RxD/TxD-P * Receive/transmit data - positive (red) 4
4 CNTR-P Control signal for repeaters - positive (direction 

control): not used
-

5 DGND * Discrete earth 3
6 VP * Line terminator polarization voltage 1
7 P24 Output voltage, 24 V -
8 A-RxD/TxD-N * Receive/transmit data - negative (green) 2
9 CNTR-N Control signal for repeaters - negative (direction 

control): not used
-

NOTE : (*) Signals in bold and with an asterisk  are mandatory and must be 
provided. Other signals are optional.

Operating Mode

Follow the steps below:

Step Action
1 Connect the chaining cable to the BUS IN connector.
2 If the unit is at the end of the  line, connect a line terminator (FTX DPTL12) to the 

BUS OUT connector.

Otherwise, connect a connection cable to the BUS OUT connector.
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PROFIBUS Network Interface

Address Configuration / Transmission Speed

Method

Follow the steps described below:

Step Action
1 Switch off the Splitter Box.
2 Unscrew the four screws on the cover and remove it.
3 Set the splitter box address using the rotary switches.
4 Screw the cover back on (0,5...3 Nm (4.4...26.5 lb-in)).

 WARNING
EQUIPMENT DAMAGE

•	 Turn off power supplying th Splitter Box before openin th cover.
•	 Do not touch electrical circuit components contained in the Splitter Box.

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.

Rotary Switches

Element Function
1 Node-ID x 10 rotary switch
2 Node-ID x 1 rotary switch

Assignment of the Address on the Network

The addresses can be configured from 0 to 99. However the following addresses are 
reserved:

•	 0 to 1: for the DP clients,
•	 2 to 99: for the servers.

When assigning the addresses, each server and/or client must be assigned to a 
specific and unique address. A configured address is acknowledged at boot-up. It 
cannot be modified if the cover is not removed.

NOTE : The default factory setting is the address 2.

NOTE : Any change to the Splitter Box  address shall be taken into account 
only once it is powered on again. 

21
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PROFIBUS Network Interface

Automatic Transmission Speed

At power up, the Splitter Box is in listening mode in order to adapt its transmission 
speed to the one used on the network. As soon as it is detected by the client, it 
receives its configuration and settings data. Once the configuration is over, it is 
operational and ready to exchange data.

Transmission Speed and Cable Length

Each transmission speed has a corresponding cable length.

The following data is indicated without a repeater and with a maximum of 32 servers 
on the segment.

Transmission speed in Kbits/s Maximum cable length in m (ft)
≤ 93.75 1200 (3937)
187.5 1000 (3280.83)
500 400 (1312)
1500 200 (656)
≥ 3000 100 (328)
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PROFIBUS Network Interface

End of Line Termination
Description

Each PROFIBUS segment start and end must have a line termination. 

The splitter box has no active line termination. You must use an end of line 
termination on the OUT PROFIBUS connector if you place the splitter box at one of 
the ends of a bus segment.

Reference

Reference Designation
FTX DPTL12 Line termination

General Principles
Introduction

This section addresses the general principles for operating and using the 
PROFIBUS fieldbus.

About the PROFIBUS Network
PROFIBUS and PROFIBUS-DP

•	 PROFIBUS is an open and independent communication standard adapted to 
industrial applications.

•	 PROFIBUS-DP (Process Fieldbus Decentralized Peripheral) is the PROFIBUS 
version optimized for high speed data transmission within a decentralized I/O 
architecture.

Role

•	 PROFIBUS enables devices from different manufacturers to communicate 
without needing a specific interface.

•	 PROFIBUS-DP is particularly adapted to applications for which the response 
time is a critical factor.

Client/Server Communication

Compatibility between the physical equipment installed and the configuration 
expected by the application is controlled during client and server communication 
establishment. The client sends the server configuration and settings data as soon 
as it recognizes the equipment installed. The server provides diagnostic information 
to the client about its operating state.

The physical link is a type A shielded twisted pair.

The data exchange between the Client (the processing unit) and the Servers 
(decentralized devices) is carried out on a cyclical basis: the client sends the output 
data to the servers, which respond with their input data.
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PROFIBUS Network Interface

Servers and Repeaters

32 servers in total can be connected to a bus segment. To increase  the number of 
servers, repeaters must be added to create new bus segments.

Repeaters are also used to physically isolated bus segments. In total, the number of 
servers must not be greater than 126.

There  must be a line terminator on the bus at the ends of each new segment.

Operating Diagram

PROFIBUS Standards

Openness and independence are defined by following international standards IEC 
61158 and IEC 61784. The PROFIBUS standard is detailed in standard EN 50170.

Momentum

Quantum

ATV 58E

Premium

FTB 1DP

XGS Z33PDP

FTB 1DP

P
D-subifor

P su
B

XGC S49/89

XGS Z33PDP

XGC S49/89

Behavior

Introduction

This section addresses the different behavior patterns of the OsiSense® XG 
PROFIBUS Splitter Box.
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PROFIBUS Network Interface

Behavior patterns of the OsiSense® XG PROFIBUS Splitter 
Box

Behavior at Boot-up

At power up, the Splitter Box is in listening mode in order to adapt its transmission 
speed to the one used on the network. As soon as it is detected by the client, it 
receives its configuration and settings data. Once the configuration is complete, it is 
operational and ready to exchange data.
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Data Access to OsiSense® XG Stations
Introduction

This chapter describes the data exchanges between Modbus sub-network and 
PROFIBUS network.

Data Exchanges

Presentation

The diagram below illustrates the data exchanges:

Two memory buffers are integrated in the Splitter Box XGS Z33PDP:

•	 Output Data Buffer for:
	◦ 	commands addressed to OsiSense® XG stations,
	◦ 	written from PROFIBUS network.

•	 Input Data Buffer:
	◦ results of commands addressed to OsiSense® XG stations,
	◦ status of the commands addressed to the OsiSense® XG stations.

Data Buffer Structure

The following table describes the Output Data Buffer structure of the Splitter Box 
XGS Z33PDP:

Register (16 Bits) Description
1st NA
2nd Bit 0 = Read command trigger bit
3rd Bit 0 = Write command trigger bit
4th RFID station server address (1 to 15)
5th Start address of the Read/Write command
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Data Access to OsiSense® XG Stations

Register (16 
Bits)

Description

6th Quantity of registers to Read/Write (1 to 49)
7th Quantity of bytes to Read/Write (2 x qty of registers)
8th Data 1 Used only for 

write command9th Data 2
10th Data 3
... ...
... Data n

NOTE : Communication errors can result if the maximum number of words is 
exceeded.

 WARNING
UNINTENDED EQUIPMENT OPERATION

•	 Do not excee the maximum number of words to read or write.
•	 Communication errors cn result if the maximum numbers of words is exceed. 

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.

The following table describes  the Input Data Buffer structure of the Splitter Box XGS 
Z33PDP:

Register 
(16 Bits)

Description
MSB LSB

1st Status bit (bit C): 1= ok 0= missing RFiD station, page 34
2nd NA Counter of Read commands
3rd NA Counter of Write commands
4th Total Data bytes received (Read 

command only)
Address of the RFID station

5th Command codes (03h for read - 
10h for write) and error status bit 
(bit 15)

Bit 15 = 1: negative answer from 
the RFID station and validation 
of the error code in the LSB

Error code (valid only when the error 
status bit is = 1)

For error codes, refer to OsiSense® XG 
Compact Stations user guide, p 58. 

6th Data 1 Used only for read command
7th Data 2
8th Data 3
... ...
... Data n
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Data Access Procedure

Step Action
1 From the PLC, send the data contents to the Output Data Buffer:

2 Toggle the Command trigger bit (2nd register of the Output Data Buffer for 
read - 3rd register of the Output Data Buffer for write).

The command is sent to the OsiSense® XG station.
3 Test the Counter of Read or Write commands (2nd or 3rd register of the 

Input Data Buffer), when the station has answered to the command, the 
splitter box increments this register.

4 The answer can be read by the PLC.

Note: The error status bit of the 5th register of the Input Data buffer (bit 15) 
must be tested to know if the command was successful or if an error has 
been detected (see Diagnostic, page 35).

Write Command Example

This example describes a write command of two words from address 5 to the 
OsiSense® XG station at @ 3. 

The table below illustrates the data to sent to the Output Data Buffer:

Register Description Value
4 Server address 0003h
5 Start address 0005h
6 Quantity of registers 0002h
7 Quantity of bytes 0004h
8 Data 1 0123h
9 Data 2 4567h

The table below illustrates the station answer in the Input Data Buffer (after a toggle 
of the bit 0 of the write trigger register (3rd register of the Output Data Buffer) and a 
detection of a change  in the counter of Write commands (3rd register of the Input 
Data Buffer):

Register Description Value
3 Counter of write commands (5th writing 

command in this example)
05h

4 Address of the station (Total Data bytes 
received is not applicable)

xx03h (only the LSB is valid 
for a write command)
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Data Access to OsiSense® XG Stations

Read Command Example

This example describes a read command of two words from address 5 to the 
OsiSense® XG station at @ 3. 

The table below illustrates the data to sent to the Output Data Buffer:

Register Description Value
4 Server address 0003h
5 Start address 0005h
6 Quantity of registers 0002h
7 Quantity of bytes 0004h

The table below illustrates the station answer in the Input Data Buffer (after a toggle 
of the bit 0 of the read trigger register (2nd register of the Output Data Buffer) and a 
detection of a change  in the counter of Read commands (2nd register of the Input 
Data Buffer):

Register Description Value
2 Counter of Read commands (5th reading command in this 

example)
05h

3 Counter of Write commands xxxxh
4 Total Data bytes received and address of the RFID station 0403h
5 Command code and error code 0300h
6 Data 1 0123h
7 Data 2 4567h
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Software Installation
Introduction

This chapter provides all information required for the software installation of 
OsiSense® XG PROFIBUS Splitter Box.

Installation with PL7 Pro/Unity/SyCon

Pre-requisites
Below is a description of how to install an OsiSense® XG PROFIBUS Splitter Box 
server with a Premium PLC associated to the TSX PBY100 communication coupling 
device, using the PL7 Pro or Unity software workshop.

The pre-requisites for installation are as follows:

•	 The GSD file (SE100BBB.GSD) have been imported in SyCon
•	 The PL7 or Unity and SyCon software have been installed.

The latest version of the GSD file is available on the https://www.se.com website.

See documentation for the client used if system is installed in a different 
environment.

First Phase: Installation Using the SyCon Tool

The first phase is performed using "SyCon", the PROFIBUS network configuration 
tool. This tool is used to define the bus architecture and its communication settings, 
as well as to  configure and set the servers using their corresponding GSD files. 

SyCon generates an ASCII file containing all the network management data required 
by the Schneider PROFIBUS client. 

Perform the following steps to configure the Splitter Box:

Step Action
1 In the menu Insert select Client.... 

Add the TSX PBY100 Client module.

2 Access the client configuration menu by double-clicking the client icon or by 
selecting the Client Configuration... option in the Settings menu.

Check that the Auto addressing check box is ticked.

https://www.se.com
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Step Action

3 Configure the bus by clicking on the menu Settings -> Bus Parameter...

4 In the menu Insert select Server.... 

Configuration is carried out by selecting the Splitter Box to be installed. 

In the following illustration, the XGS Z33PDP Splitter Box can be selected 
from the "Available servers" list, which corresponds to the SyCon software 
workshop product catalog library.

5 Access the configuration menu by double-clicking the product icon (see 
illustration below) or by selecting the Server Configuration... option in the 
Settings menu.
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Step Action

6 Select one IN/OUT module in the list, then insert it into the second 
table by clicking on the Add Module button. Add more modules if 
necessary (Input data length = 14...112 bytes - Output data length = 
10...112 bytes).

Check  that the check boxes Activate device in actual configuration 
and Enable watchdog control are ticked.

7 The length of the input or output data is indicated in the columns:
•	 "I Len": Input length
•	 "O Len": Output length

The length also depends on the data type ("Type" column):
•	 "IW": Input word
•	 "OW": Output word
The address of the input or output data in the PLC memory is shown in 
the columns: 
•	 "I Addr.": Input address
•	 "O Addr.": Output address

NOTE : The start address of the input or output data can be 
modified by the user if the "auto addressing" function is deactivated 
in the SyCon software workshop.
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Step Action

8 Save the configuration file (name.pb), File → Save As...
9 Select the client by clicking on  its icon.

Export the ASCII configuration file (name.cnf), File → Export → ASCII

Note: The export is possible only if the client is selected.

Second Phase: PL7 Pro/Unity

The second phase is performed by PL7 Pro or Unity. Once the ASCII file is selected, 
the client initializes the network devices and gives them the start-up command. 
Proceed as follows:

Step Action
1 In the TSX PBY100 card configuration screen, select the ASCII configuration file 

(.cnf) generated by SyCon by clicking on the Load CNF button.

The "PROFIBUS-DP server configuration" area then shows all the configured 
servers. In the following illustration, the client is at address 2 and the  
PROFIBUS Splitter Box is at address 10.

By clicking a line corresponding to a server, you can see the address and length 
of the modules declared using SyCon.

The length of the PLC's diagnostic buffer is set to 32 bytes by default. However, 
it may be  set to up to 244 bytes (maximum length) to prevent any overflow.

2 Validate the config by clicking on Validate in the Edit menu.
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Write Command Example

This example describes a write command of two words from address 5 to the 
OsiSense® XG station at address 3.

The table below illustrates the data to send to the output data buffer:

Output Word 
(%QW)

Description Value
MSB LSB

0 NA -
1 00 NA -
2 NA Write command trigger byte -
3 00 Server address 0003h
4 Start address 0005h
5 00 Quantity of registers 0002h
6 00 Byte count 0004h
7 Data to write 1 0123h
8 Data to write 2 4567h

NOTE : For a write command, 25 words maximum can be writen. 

The table below illustrates the station answer in the input data buffer (after a toggle 
of the command trigger byte  %QW.x.y.2 and a detection of a change in the counter 
byte %IW.x.y.0.1):

Input Word 
(%IW)

Description Value
MSB LSB

0 Status word -
1 00 NA -
2 00 Write command count -
3 Total byte count Server address 0503h
4 Command code NA 1000h

The table below illustrates the station answer in the input data buffer if the tag is 
missing :

Input Word 
(%IW)

Description Value
MSB LSB

0 Status word -
1 00 NA -
2 00 Write command count -
3 Total byte count Server address 0503h
4 Command code Error code 9004h
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Read command example

This example describes a read command of two words from address 5 to the 
OsiSence® XG station at address 3.

The table below illustrates the data to send to the output data buffer:

Output Word 
(%QW)

Description Value
MSB LSB

0 Command word -
1 00 Read command trigger byte -
2 NA NA -
3 00 Server address 0003h
4 Start address 0005h
5 00 Quantity of registers 0002h

NOTE : For a read command, 27 words maximum can be read.

The table below illustrates the station answer in the input data buffer (after a toggle 
of the command trigger byte %QW.x.y.1 and a detection of a change in the counter 
byte %IW.x.y.0.1):

Input Word 
(%IW)

Description Value
MSB LSB

0 Status word -
1 00 Read command count -
2 NA NA -
3 Total byte count Server address 0903h
4 Command code Read data byte count 0304h
5 Read Data 1 0123h
6 Read Data 2 4567h

The table below illustrates the station answer in the input  data buffer in case of  
addressing error (out of memory range):

Input Word 
(%IW)

Description Value
MSB LSB

0 Status word -
1 00 Read command count -
2 NA NA -
3 Total byte count Server address 0903h
4 Command code Error code 8302h
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Diagnostics
Introduction

Diagnostics information simplifies installation and accelerates error searching 

This chapter provides the elements necessary for diagnostics by:

•	 LED display,
•	 Software.

Diagnostic LEDs

Description

6 LEDs allow you to diagnose the Splitter Box communication status:

No. DEL Status Description
1 ONLINE Off PROFIBUS-DP bus: Splitter Box off-line

Green PROFIBUS-DP bus: Splitter Box on-line (exchanges are possible)
2 OFFLINE Off PROFIBUS-DP bus: Splitter Box on-line

Red PROFIBUS-DP bus: Splitter Box off-line (exchanges are impossible)
3 NOT USE Off -
4 FIELDBUS DIAG Off Initialization achieved

Flashing red  (1 or 
2 Hz)

Configuration error (1)

Flashing red (4 Hz) Error when resetting the Splitter Box on PROFIBUS-DP (1)

5 MODBUS Off No power
Flashing green No Modbus communications
Green Modbus communications OK
Red •	 Loss of communications with at least one Modbus server (2)

•	 Exception code coming from a command or a transaction
6 GATEWAY Off No power

Flashing (red/green) Configuration absent / not valid (Use ABC-LUFP Config Tool to load a 
valid configuration)

Green Splitter Box currently being initialized and configured
Flashing green Splitter Box is in running order, configuration OK

6 4 2

5 3 1
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(1) Specific errors indicated by the LED 4 FIELDBUS DIAG  

•	 Flashing red LED (1 Hz): input and/or output data length is invalid. 
•	 Check the overall length of the Splitter Box data, under ABC-LUFP Config Tool 

("Monitor" option from the "Sub-Network" menu), then adjust exchanges with 
the Splitter Box accordingly, using  the PROFIBUS-DP network configuration 
software (e.g.: SyCon). 

•	 Flashing red LED (2 Hz): User parameter data length and/or content is invalid. 
•	 Flashing red LED (4 Hz): Error when resetting the ASIC in charge of 

PROFIBUS-DP communications. 

(2) The LED 5 MODBUS becomes red when one or more Modbus servers fail to 
respond to the Splitter Box in the expected fashion. This can be caused by:  

•	 Loss of communications (e.g. a broken or disconnected cable).
•	 Writing incorrect values to the outputs corresponding to the two aperiodic read/

write services 

NOTE : When LED 5 MODBUS is flashing red due to a simple loss of 
communications, the LED will revert to a green state when communications are 
restored. When LED (5) is flashing red due to the use of incorrect values with 
the aperiodic read/write services, then the only way to clear the error is to reuse 
these aperiodic services with correct values. 

NOTE : If the LED 6 GATEWAY is flashing with a sequence beginning with one 
or more red flashes, cycle the Splitter Box power Off and then On again. If this 
does not stop the flashing note the order of the sequence and contact TMSS 
support service.
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Software Diagnostics

Status Bit Description

A Status Bit of the stations connected to the Splitter box is located at address 0000h 
of the Splitter Box input memory:

Bit Description Value
F NA -
E
D
C Status Bit - 1: in normal conditions

- 0: if at least one RFID station is missing
B NA -
A
9
8

 WARNING
UNINTENDED EQUIPMENT OPERATION

•	 Always initialize the Splitter Box by cycling the Power Off then On before connecting a 
new station.

•	 Always stop communications from Profibus-DP network to the Splitter Box until full 
setup of the new station. 

Failure to follow these instructions can result in death, serious injury, or equipment 
damage.
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